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Introduction to Silent Partner SPHD 
 
The Silent Partner SPHD by Northwood Power Instruments Inc. 
represents the leading edge in low cost current and voltage 
recording. The design of the Silent Partner SPHD draws on 
Northwood’s experience of over a decade in the field of solid-state 
recording. High reliability surface mount components and state of 
the art technology make the Silent Partner SPHD the most 
dependable, low cost, True RMS logger available. 
 
The Silent Partner SPHD is an ideal recorder where small size and 
portability are required. Durability and ease of operation are built in. 
The software is full featured and easy to use and understand. 
 
 

Features 
 
 
 True RMS Measurements.  Measure voltage or current on any channel. 
 12 Bit Resolutions.    Powered by internal battery and adaptor. 
 ± 0.25% Accuracy.    Downloads with Silent Partner software. 
 Longer battery life.    Heavy duty case.  

 
Sample Applications 
 
Because the Silent Partner SPHD uses a 12-bit A/D converter, it 
can be used to monitor many devices where accuracy is important. 
Some possible applications: 
 
• Energy Studies 
• Machinery and motor analysis 
• HVAC studies 
• Electrical Utilities 
• Peak shaving and Load Management 
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The Logger - Inside Front Cover 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Battery Charger Indicator: 
When the Battery Charged light is ON it indicates that the battery is 
charging. When the Battery Charge light is OFF it indicates that the 
battery is not fully charged. 
Low Battery LED: 
When the Low Battery light is Blinking it indicates that the battery is 
LOW and need to be fully charged. When the Low Battery light is 
OFF it indicates that the battery is fully charged. 
Recording light: 
The Recording light blinks while Silent Partner SPHD  is logging. 
Sleep button: 
The Sleep button is a recessed control. Press the Sleep button 
before disconnecting or transporting Silent Partner SPHD  to stop 
the logging function and power down the logger to standby mode. 
This minimizes the risk of data loss and prevents the logger from 
recording 0 data levels after it has been disconnected. 

RESET button 

Sleep button 

Recording light 

Purge Valve 
knob  

Battery Charger 
Indicator Low Battery LED  
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RESET button: 
The RESET button is a recessed control. Press RESET after 
transporting the logger to the survey site and connecting it. 
Resetting clears the logger's memory, clears the Under 
Voltage/Over Voltage and Over Current event detection lights, and 
begins a new survey.  
 
 
Because resetting clears the logger's memory, make sure to 
download any logged data before pressing RESET. 

 
 
The Logger - Connectors  
 

 

 
 
 
 
Current and Voltage logging: 
There are 3 labelled connections for Current/Voltage logging. 
These labels correspond to the Ch1, Ch2 and Ch3 labels that 
appear in dialog boxes. 
 
 
 
 
 
 

Download 
Connector & 
charger Input 

Connections 
for voltage 

logging using 
volage 
modual 

Connections for 
current logging 

3 channels 
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Silent Partner PowerPack and Windows® 
 
Silent Partner PowerPack is a Windows-based application so you 
will find the interface familiar. It employs the same menu structure 
and screen navigation as other Windows programs. Simply make 
selections using a mouse, or from the keyboard by pressing the 
underlined letter of the command you wish to select. Dimmed menu 
items are unavailable.  
Silent Partner also uses Windows file management functions. 
 
To do this…. click File then click here. 
select a previously stored survey  

 

save a survey with its current name  
save a survey with a new name  
delete an existing survey  
export a survey in Lotus.WK1 format  
print the current report or change print setup  
exit Silent Partner PowerPack software  
 
For additional information on using Windows refer to your Windows 
documentation or on-line Help. 
 

Important Safety Notice 
Although this device is designed to be as safe as possible, safety in use is the 
responsibility of the operator who must be suitably qualified and / or authorized. 
 
• The device should not be brought into contact with any surface water, as the 

unit is not hermetically sealed, and ingress of water could damage the 
electronics as well as causing a potential shock hazard. 

• Never work alone with high voltage circuits. Make certain that a qualified 
observer is watchful and aware of your intentions. 

• When installing the device near high voltage circuits, connections should be 
made to the circuits while the power is off. 

• NEVER exceed the maximum input to the logger of 1-volt RMS. Doing so could 
result in personal injury and or damage to the logger. 
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Quick Start 
This section provides an overview to help you get started quickly. 
Please read through the remainder of this manual for important 
information on the correct setup and use of the Silent Partner 
SPHD logger and Silent Partner PowerPack software. 
Preparing to Log: 
1. Install Silent Partner PowerPack software. 
2. Start Silent Partner PowerPack software. 
3. Connect the Silent Partner SPHD logger at the PC serial port. 
4. Select the logger type and serial port, set the time and date, 

and specify the data logging parameters. 
(Setup, Logger Serial Port), (Logger, Set Time and Date) 
(Logger, Change Parameters) 

5. Disconnect the logger from the PC. 
6. Connect the logger to the load you wish to monitor. 
7. RESET the logger to begin your survey. 
 
After Your Survey: 
1. Disconnect the logger from the load and connect it to the PC. 
2. Start Silent Partner PowerPack and download the data. 

(Logger, Download SP Data) 
3. Setup the Power, Costing or Pulse calculations. 

(Setup, Range/Power), (Setup, Range/Power), 
(Setup, Pulse Rate Period)  

4. Select a display group. 
(Setup, Measurement Scale) 

5. Select a report type. 
(View, report type) 

6. Tailor the report's appearance to suit your needs. 
(Setup, Display/Print Options) 

7. Print the report and save the file. 
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Installing Silent Partner PowerPack Software 
 
System Requirements: 
 
Windows 3.1 or greater 
VGA display (colour recommended) 
COM1, 2, 3, or 4 (serial communications port) 
Hard disk with 1 megabyte free 
 
Before you can use your Silent Partner logger, you need to install 
the software. Your computer must be IBM compatible, running 
Windows version 3.1 or better, with a VGA display (colour strongly 
recommended), and a hard disk or network drive with at least 1 
megabyte of free space. Although not essential, a mouse makes 
using the Silent Partner software much easier and faster. You 
should be familiar with running applications in Windows. 
 
To install the software: 
 
• Make sure that your computer is running Windows. 
• Insert the Silent Partner distribution disk in drive A:. 
• Select Program Manager (click the Start button in Windows). 
• Select Run from the File menu (click Run in Windows).  
• In the Command Line dialog, type "A:\SETUP" . 
 
Setup will ask if you want to change the default names for the Data 
Directory and the Export Directory. These are the directories where 
downloaded data and export data are stored. After you click on OK, 
Setup will begin installing the software to your hard drive. A 
program group called Silent Partner will be created containing the 
Silent Partner icon. As with any Windows application, the Silent 
Partner software is run by double clicking the icon with the mouse. 
Now that the software installation is complete, you can begin using 
your Silent Partner right away. 
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Logger Hookup 
 
• If you have not already done so, you should install the software 

and set the Silent Partner SPHD’ internal clock to the correct 
time, number of channels and storage rate. 

 
• Test the Silent Partner SPHD before you install it. Press the 

recessed RESET switch using a pen (see below). If the device 
is running properly, the red LED should flash for 1 second, then 
blink every other second. 

 

!  
 

 
 
• Place the Silent Partner SPHD in the area to be logged. 
 
• Press the RESET switch to clear memory begin a new survey. 

The LED will flash for 1 second to indicate a reset, and then it 
will begin recording. The LED will blink approximately every 
other second to confirm that you are logging. The LED will stop 
blinking when the end of memory is reached if wraparound 
memory mode is disabled. 

 
• When your survey is complete, press the SLEEP button to put 

the logger in low power mode and disconnect the logger. 
 
If you press RESET and then hook up the logger, you may end up 
recording some zeros at the beginning of the survey. To avoid this, 
hookup the logger first, then press RESET. Similarly if you want to 
avoid zeroes at the end of the survey, make sure you press the 
SLEEP button before disconnecting the logger. 
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Using Silent Partner Software 
 
There are several options that can be set up to control how graphs 
are displayed, the directories that Silent Partner uses, etc. For 
details on these option settings, please refer to the section entitled 
Setup (page 277). 
 
 
A Short Note About the Time and Date Format: 
 
The time and date format in the various reports will appear in the 
format you have selected in the International Settings section of 
Windows Control Panel. For instance, if you setup Windows to use 
24 hours time format, Silent Partner will display all times in military 
or 24 hour format. 
 
After double clicking the Silent Partner icon, the opening screen 
will appear. 
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After a few seconds, the title screen will disappear and the main 
title bar will appear. 
 

 
 
The main menu is divided into five sub-menus; File, View, Logger, 
Setup and Help. Notice that there is one letter underlined in each 
command (the F in File, the V in View, etc.). This allows users 
without a mouse to invoke commands using the keyboard by 
depressing the ALT key and the underlined letter. This is a feature 
common to all Windows applications, and can be used for any of 
the commands in the Silent Partner software. 
 
If a selection in a menu is dimmed out or you can’t select it, it 
means that that particular choice is not available to you. This may 
be due the fact that there is no data loaded (e.g. trying to View a 
graph when you have not loaded or downloaded any data yet), or it 
may be a feature only available to a different type of Silent Partner 
logger. 
 
A summary of each menu and its associated functions follows. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Silent Partner Software Command Summary 
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Each main menu has an associated drop down menu that allows 
you to execute a particular function. Below is a brief description of 
each menu and all of its related functions. 
 
 

File 
 
The File menu groups all of the functions required to manipulate 
Silent Partner data files. 
 

 
 
 
Open 
Retrieves a previously stored survey file. Selecting Open will 
display the file selection dialog box: 
 
 

 
 
 
To retrieve a file, double click on the file name from the pick list or 
enter the file name in the file name box and click on OK. Note that 
all Silent Partner SPHD files use .CLS as their extension. If the file 
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you wish to retrieve is not in the current directory, you can select a 
different directory using the directory tree list, or by entering the 
directory name. The default directory is the directory specified in 
the Setup section of the program (see page 277 for more details).  
 
Save 
Saves changes to the survey you have been working on. This 
function is useful if you have downloaded a file but opted not to 
save it at the time of downloading, or if you have changed the 
summary information or notes and want to update the survey file. 
The survey is re-saved under the original file name if it was saved 
before; otherwise you are prompted for a file name. To save a 
changed file under a different name, use the Save As function. 
When you choose Save, the survey remains loaded so you can 
continue working with it if you wish.  
 
Save As 
Saves a new or existing survey. You can name a new survey or 
save an existing survey under a new name. The original survey 
remains unchanged. When you choose Save As, the survey 
remains loaded so you can continue working with it if you wish.  
 
Delete 
Deletes a survey file. The file select dialog will appear to allow you 
select which file to delete. 
 
Export 
Translates the current survey into Lotus WK1 format. The time and 
date of each measurement is exported, along with the reading. This 
feature allows you to transfer your data into spreadsheet and 
graphics programs to create custom reports. 
 
 
 
 
 
 
Print 
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Prints out the report that is currently on the screen. You can also 
choose which printer to use, and setup certain features of your 
printer. 

 
 
 
The top of the Print dialog box will tell you which printer is currently 
selected. The Print Range section allows you to define the days 
that are included in the printout. For example, you could print one 
or two days of graphs from a 30-day survey (this can save a lot of 
paper). To change the date range, select the Dates selector. 
Choose the starting and ending dates using the sliders below the 
From and To headings. You can also select whether or not to print 
a summary report with each printout. The summary report contains 
statistical information, user notes and the start and stop times of 
the logger. 
 
Note: The statistics printed are based on the selected print 
range, not the entire logging period. 
 
Clicking the Setup button will allow you to choose which printer to 
use, and to change certain options for the printer. 
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The Default Printer is the primary printer as specified by the 
Printers section in Windows Control Panel. If you want to print to 
another printer, select the Specific Printer selector. You will then 
be presented with a list of the available printers installed in 
Windows. If the printer you want to use is not on the list, you must 
load the appropriate Windows driver. For information on installing 
Windows drivers, please consult your Windows manual. 
 
Clicking the Options button will allow you change the operational 
setup of your printer. Here you can change printer options such as 
print darkness, resolution, orientation, etc. The options available 
will vary depending on the printer you have. Please note that the 
summary page always prints out in portrait mode. 
 
Exit 
Quits the program. 
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View 
 
The View menu allows you to select how to display your data. 
 

 
 
 
 
Survey Summary 
 

 
 

Displays summary information and notes about the current survey. 
This information is useful for finding out how long the Silent Partner 
was actually logging, when it was started, when it stopped logging, 
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and the range for each channel. You can also enter in a survey 
title, notes, or other descriptive text to identify your report. Selecting 
the Range button allows you to select the appropriate CT and/or 
PT range. This value is normally set and sent to the logger during 
the setup process. 
 
 
Measurement Graph 
 

 
 
 
Displays a graph of each measurement according to time. The 
number of days along the bottom of the graph is set using the 
Graph Length selector in the Graph Options menu (see page 298 
for more details).  
 
The scale on the Y-axis can be changed using the Measurement 
Scale function in the Setup menu (see page 277 for more 
information). The Y-axis can also be zoomed or unzoomed via the 
View menu (page166). 
 
The graph can be scrolled horizontally by clicking the mouse on the 
scroll bar at the bottom. It can also be scrolled using the keyboard: 
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• ←and → move the graph forward or backward by one period. 
• Home will return the display to the beginning of the survey. 
• End will advance the display to the end of the survey. 
• Page Up and Page Down advance the graph by one full period. For instance, 

if you are viewing a 7-day graph and press Page Down, the next 7 days will be 
displayed. 

 
Measurement List 

 

 
 
 
The measurement list is a listing of the actual readings and the 
time and date on which they occurred. This list represents the 
same data as the Measurement Graph, only in numerical form. 
 
The list can be scrolled vertically by clicking the mouse on the 
scroll bar on the right hand side. The list can also be scrolled using 
the keyboard: 
 
• ↑ and ↓ moves the list up or down one item. 
• Page Up and Page Down will move the list up or down by one page. 
• Home will move to the beginning of the list. 
• End will move to the end of the list. 
 
Zoom 
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Zoom allows you see more resolution (detail) when viewing graphs. 
In the unzoomed mode, the Y - axis will be scaled from the lowest 
to the highest value in the logger’s range. For example, if you had a 
Silent Partner SPHD that was configured for 1000 amp CT’s, the 
unzoomed Y-axis would be scaled from 0 to the full-scale value (in 
this case, 1000 amps). If you select Zoom, the software will scan 
the data to obtain the highest and lowest values recorded. These 
two values will then be used as the upper and lower Y-axis values. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Logger 
 



Page 20 

 
 
Before executing any of the following commands, the Silent 
Partner must be connected to the correct serial port. Serial ports 
are usually found on the back of the PC, and are always either a 
male 9 pin connector. 

 
 

 
If your computer has more than one serial port, make sure you 
connect to the same port that you specified in Setup. If you are not 
sure which port you are connected to, you can have Silent Partner 
find that out for you. For details on selecting or searching for serial 
ports, Please refer to the section in Setup called Logger Serial 
Port on page 27 for more details. 
 
 
 
 
 
 
 
Set Time and Date 
Synchronizes the Silent Partner's internal clock to the time and 
date of the computer's clock, clears memory and resets the logger. 
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After selecting this function, Silent Partner will stop to confirm that 
you really want to clear the logger. 

 
REMEMBER - SETTING THE TIME CLEARS THE LOGGER’S 

MEMORY ! 
 
 

 
 
 

Selecting Cancel will abort the operation. Selecting OK will set the 
logger time to the computer’s time and clear the memory. 
 
 

 
 
  
Since the PC’s time is sent to the logger, it is important to make 
sure that your computer's time and date are correct. 
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Read Status 
 

 
 
 

Displays operational information about the logger such as logger 
type, firmware revision, record count, clock time, present reading 
for each channel, channel configuration, battery voltage, and 
whether Wraparound recording is enabled. This is a useful function 
for verifying that the logger is operating properly and 
communicating with the PC. 
 
 
Download Data 
Retrieves all of the data from the Silent Partner SPHD. Note that 
downloading does not destroy the data, so the logger can be 
downloaded as often as you want. Before downloading, connect 
the Silent Partner SPHD to the download cable, and then connect 
the cable to the back of your computer. Please note that 
communications ports on most PC's are 9 pin or 25 pin male 
connectors. If your port uses a 25-pin connector, you may need to 
use a 25 to 9 pin adapter (available at most computer stores or 
from Northwood). After selecting Download Data, Silent Partner 
will inform you that it is initiating communications with the logger. 
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As the data is transferred, you will see a completion gauge telling 
you how the download is progressing. 
 
 

 
 
 
After downloading, a short message is displayed about the amount 
of data transferred. Next you will be prompted to fill in the summary 
information screen. This screen allows you to enter in a survey title 
as well as several lines of notes. The notes section is often used to 
record such items as site details, the logger serial number, contact 
names, addresses, etc. 
 
 
Pressing the RANGE button will allow you to examine the current 
range scaling for each channel. 
 
 
When the information is filled in to your liking, pressing the OK 
button brings up the file save dialog where you can enter a file 
name. The extension for all Silent Partner SPHD files is .CLS, and 
this is automatically appended to all file names. If you don't want to 
save the file or you want to look at the data first, you can press the 
Cancel button. You can save the data at any time later using the 
Save option in the File menu. 
 
 
After pressing the OK or CANCEL button, the screen will clear and 
the Measurement Graph will be displayed. You can view your data 
in graphical or tabular form by choosing one of the display types 
from the View menu. For further information on display types, 
please see the section regarding the View menu on page 166. 
 

Change Parameters 
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Change Parameters allows you to configure how the logger will 
operate. 
 
 

 
 
 

Samples 
By moving the slider, you can set how often the logger will store a 
reading. Readings can be stored anywhere from once every 32 
seconds to once every 15 minutes, in increments of 1 minute. 
When you move the slider, the values for the Storage Interval and 
the Survey Length will automatically change. As you increase the 
Storage Interval, the Survey Length also increases.  
 
 
Wraparound Mode 
Checking the Wraparound Mode box causes the logger to replace 
the oldest data with the newest reading when the end of memory is 
reached. This feature is useful for making sure you always have 
the most current data. If an X does not appear in the Wraparound 
box, the logger will stop recording when memory is full and enter 
SLEEP mode to conserve power. 
 
Channel Configuration 
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Checking or unchecking each box allows you to enable or disable 
recording for individual channels. Disabling channels allows you 
use the memory allocated to the disabled channels to record longer 
surveys.  Beside the check box is the currently selected channel 
sensor and range for each channel. If there is no text beside the 
channel name, the channel is configured the same as the channel 
above it. To change the sensor or range, see below. 
 
 
Min/Max and Average 
Checking or unchecking the Min/Max or Average boxes allows you 
to choose which values the logger stores. Minimum values are the 
lowest reading collected by the logger during the storage interval, 
and Maximums represent the highest reading collected during the 
storage interval. The Average value represents the mathematical 
average of all of the readings taken during the storage interval. 
 
 
Range 
 

 
 
 
Pressing the Range button allows you to select from a list of 
preconfigured CT or PT ranges.  Note that only one range can be 
set for each data type. For example, if you were recording two 
currents and one voltage, you would be able to select one range for 
current and one range for voltage. 
 



Page 26 

 
 
Sensor 
 
 

 
 
 
Pressing the Sensor button allows you to define what type of input 
each channel is to have. Presently, the Silent Partner SPHD 
supports voltage and current inputs. 
 
Update 
Click on this button when you wish to send the new parameters to 
your logger. 
 

UPDATING PARAMETERS WILL RESET THE LOGGER AND 
CLEAR MEMORY! 

 
Please be certain this is what you want to do before clicking on 
Update. Click Cancel if you decide not to change any of the 
logging parameters. Please note that the software checks the 
battery voltage before sending the new configuration. If the battery 
voltage is below 8.0 volts, a warning is displayed suggesting that 
you charge the battery. 
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Setup 
 

 
 
The Setup menu allows you to specify how graphs and tables will 
appear, where data is stored, and other operational options of the 
program. 
 
 
Logger Serial Port 
 

 
 
Allows you to select which communications port the Silent Partner 
is connected to. If you experience problems communicating with 
the logger, make sure you have selected the correct port. 
 
If you don't know which port your Silent Partner is connected to, 
you can use the Scan Ports for Logger feature. Selecting this 
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feature initiates an automated search all of the installed serial ports 
for the presence of a Silent Partner logger. 
 
To search for the correct serial port, follow this procedure: 
 
• Select SPPlus in the Select Logger Type box. 
 
• Plug the Silent Partner download cable into the back of the PC. 

Serial ports are always either a 9 pin male DB9 connector or, 
on older computers, a male 25 pin DB25. Connect the other 
end (male 3.5 mm. stereo plug) to the Silent Partner logger. 

 
• Click on the Start Port Scan for Logger button. 
  
• The software will begin to search all of the available serial ports 

installed on your computer for the presence of a Silent Partner 
SPHD logger. A dialog box informs you which port is being 
tested, and whether or not a logger has been found. 

 
• If the software reports that a logger was found, that serial port 

will be selected as the download port when you press OK. 
 
• If the software does not find a logger, try moving the download 

cable to another connector at the back of the computer. If you 
still cannot communicate with the Silent Partner, there may be 
a problem with your computer's communications interface. 

 
Survey Description 
Allows you to edit or change the survey file summary notes. For a 
complete description of the survey summary, please refer to the 
View menu (page 166). 
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Graph Options 
 

 
 
 
Graph, Print List Length 
Allows you to select the period displayed on the X - axis (bottom) of 
the measurement graph.  
 
 
Overview Graph Style 
The overview graph is only available for SPA activity loggers and is 
not used with the Silent Partner SPHD. 
 
 
Measurement Y-Axis 
Silent Partner allows you to select the number of Y - axis scales to 
use when recording two or three channels. If you select Single, all 
channels will be plotted against a single scale, located on the left-
hand side of the graph. This is useful when you are trying to 
compare two similar trends against the same scale. If you select 
Dual - Left/Right, channel 1 will be plotted against the scale on the 
left-hand side of the graph and channels 2 and 3 will be plotted 
against the scale on the right hand side. Multiple scales are useful 
when the readings on each channel are significantly different. 
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Trace Selections 
Trace Selections allows you to show or hide individual traces on 
the graphs. Checking the box beside the trace name will cause the 
trace to be plotted, whereas clearing the check box will hide the 
trace. This feature is handy for removing screen clutter, especially 
if you have recorded min, max and average values for all three 
channels. If the trace names for a particular channel are dimmed 
out, the channel was not recorded and therefore can’t display any 
data. 
 
Pressing the All On button will select all traces for display. 
 
 
Measurement Scale 
 
 
 

 
 
 
The measurement scale allows the user to select the units of 
measurement for the logger readings: 
 
• Raw Data is the actual sampled data stored by the logger with 

no scaling or engineering units applied. 
• Scaled Data displays the data with the correct scaling and 

units as specified when the logger was initialized (see section 
on Change Parameters on page 24). 

 
 
 
 
 
 
 
 
Directories 
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Specifies where survey files and export files are located. The Data 
File Directory is the directory that Silent Partner will store all 
downloaded data. It is also the default directory from which files are 
retrieved. The Export File Directory is the directory where files 
created using the Export function (in the File menu) are stored. 
 
Header 
Header setup allows you to customize your printed reports by 
incorporating a company logo or graphic, as well as two lines for 
company address, report author, etc. 
 
Use Header For: 
Determines what pages will include the header info. 
 
Logo Bit Map 
You can include a bit map file in your printouts by pressing the File 
button and selecting the file name. Silent Partner will load the bit 
map file at the top left of the printed page. Please note that there is 
no scaling performed, so if the graphic appears too big or too small, 
you must change the file using a paint program. The software 
allows you to load any .BMP or .DIB bit map files. 
 
 
 
 
Header Text Lines 
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This section allows the entry of 2 additional lines of text that will 
appear at the top of each report, just underneath the logo file. 
These lines are also useful if you do not have a logo file to display. 
 

 
 

 
Help 
 
About 
 

 
 
The About function displays the sign-on screen and current version 
number of the Silent Partner software. 
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Hardware Specifications 
 

 Specification Notes 
Max. Channels Three Selectable storage for 1, 

2, or 3 channel operation. 

Range 0 - 1 VAC input. Actual current range 
depends on CT used. 

True RMS for 50/60 Hz. 
operation. 

External 
Connections 

Aux. power, download. and three 1 VAC 
inputs. 

 

Sensor Type External CT’s or external voltage module.  

Sampling Rate 2 to 4 seconds. Set via Silent Partner 
software. 

Storage Rate 32 seconds to 15 minutes. Set via Silent Partner 
software. 

Parameters Stored Avg, Min/Max, or Min/Max/Avg. Set via Silent Partner 
software. 

Samples per 
Average 

16 at 32 second storage. 
256 at 15 minute storage. 

Set automatically, 
depending on storage 
rate. 

Memory 64K, non-volatile RAM. Memory size must be 
specified when ordered. 

Memory Treatment Stop when full, or wrap. Set via Silent Partner 
software. 

Storage Capacity 
43,632 readings for 1 channel, avg.  only 
(32K). 
7,272 readings for 1 channel, min/max/avg 
(32K). 

Storage available depends 
on memory size, number 
of channels and storage 
mode. 

Indicators Flashing LEDs when logging / Low on 
Battery.  

Power Internal battery and/or adapter.  6V Battery 

Battery Life At least 7 days (can also operate from 
external adapter).  

Communications RS232, support for remote setup.  

Software Silent Partner for Windows. 
Requires PC running 
Windows 3.1 or greater 
and 1 free serial port. 

Packaging Rugged, Heavy Duty Case .  
Accuracy ± 0.25 % Range + CT or PT error  

Safety Isolation of measurement circuit via CT’s 
and PT’s 

 

Operating 
Temperature - 40ºC to 60ºC  

 
Specifications Subject to Change Without Notice 
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If Things Go Wrong ... 
 
If you are having problems with your Silent Partner, consult the list 
of solutions that follows. If you still have trouble, please call your 
nearest Northwood representative or contact Northwood directly at:  
 
Phone: (+1) 905-770-3797 (Canada) 
Fax : (+1) 905-770-4167 
Cell : (+1) 647-880-0340 
Email : rcct@rccgroup.com 
Web : www.rccgroup.com 
Email : info@techno-canada.com 
Web : www.techno-canada.com 
 
 
 
Download Problems 
 
The Silent Partner will not download. 
 
• Check the download cable and make sure it is plugged into the 

right communications port on your computer. 
• Make sure you have selected the correct COM port in the 

Setup section of the software (see page 27). 
 
The software reports an “Invalid Wakeup Response.” 
 
• This message is most often displayed when the software tries 

to communicate with something other than a Silent Partner 
logger. This is sometimes due to an internal modem or some 
other device responding when the software is tries to initiate a 
conversation. If this happens, go back in to the Setup - Logger 
Serial Port section and choose a different port. 

 
“Scan Ports for Logger” says that no logger was found. 
 
• Make sure the download cable is plugged in before pressing 

the scan button. 

http://www.rccgroup.com/�
http://www.techno-canada.com/�
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• If you have unplugged a serial mouse and then plugged the 
logger into that port, it probably will not work. The reason for 
this is that the Windows mouse driver will report that the port is 
still in use by the mouse, regardless of whether or not it is 
physically connected. If this happens, Windows will not allow 
Silent Partner to use that port for communications. This can be 
overcome by using a different port for the logger if available, or 
by buying a second serial port (they are quite inexpensive). 

• Ensure that the port you are using actually works. Although 
most new PC’s are equipped with two serial ports, it is not 
unheard of for the second port to be defective. Connectors are 
sometimes put on the outside of the case that aren’t actually 
connected to anything inside. The best way to verify that the 
port is indeed working is to try communicating with some other 
device such as an external modem. 

 
 
Time and Date 
 
The time and date on all of the graphs and printouts is wrong. 
 
• Make sure you have set the logger's clock using the Set Time 

and Date function in the software (see page 20 for details). 
• Ensure that your computer's time and date are set correctly. 
• Make sure that you press the RESET button on the Silent 

Partner to begin logging.  
 
 
All of the times on the graphs and reports are in 24 hour format, 
but I want 12 hour format (or vise - versa). 
The dates appear in the wrong format. 
 
• The way in which times and dates are displayed in the Silent 

Partner software is determined by the International Settings 
portion of Control Panel In Windows. To change the settings, 
open the Main program group and select Control Panel. Select 
the icon for International Settings, and adjust the time and date 
formats to suit your preference. 

Printing 
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I click on the cancel button when printing, but the printer keeps on 
going. 
 

• Printing can continue after hitting the cancel button for several 
reasons. Firstly, Windows has a feature called Print Manager 
which acts as a background print spooler. The function of a 
print spooler is to allow printing in the background, freeing up 
your computer for more important things. If Print Manager is 
enabled, the Silent Partner software will print to Print Manager 
instead of the printer. Print Manager, in turn, will send the data 
to the printer leaving the computer free for other tasks. 
Pressing cancel will stop data from going to Print Manager, but 
it will not stop Print Manager from sending the data it already 
received to the printer. To remedy this situation, you can cancel 
the print job by selecting Print Manager from the Main program 
group. Select the proper print job from the list and delete it. If 
you wish to disable Print Manager and print directly to the 
printer, it can be disabled by opening the Main program group 
and selecting Control Panel. Next, select the Printers icon, and 
uncheck the Use Print Manager box on the bottom left hand 
side of the dialog box. For full details on the correct use of Print 
Manager, please consult your Windows Manual. 

 

• Your printer may also continue to print if it has a large amount 
of on-board memory. This memory serves the same purpose 
as Printer Manger by providing a temporary storage space for 
the printed data so the computer can move on to more 
important tasks. If your printer continues to print after pressing 
Cancel and Print Manager is disabled. Try resetting your 
printer. This should clear any data stored in the printer. If your 
printer does not have a reset switch, turn the printer off, then 
on again. 

 
Display 

 
The colours on the Graph are difficult to see on the screen. 

 
• Please refer to appendix A for details on changing some of 

Silent Partner’s Graph colours. 
Appendix A - SILPRTNR.INI File Settings 
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Silent Partner software stores most of its configuration information 
in a special file called SILPRTNR.INI. This file can be edited using 
Notepad or any other text editor. This file should only be 
modified by advanced users. 
 
Customizing Graph Colours 
If the colours used in the measurement graph aren't to your liking, 
you can change the colours used by Silent Partner. Each colour is 
defined by the amount of RED, GREEN, and BLUE. To changes 
the colours, you must edit the sections below in boldface type: 
 
[GraphPref] 
OnRGB=0,  0, 64   Box colour for 100% ON on Overview 

Graph (Not Used for SPPlus) 
1-99RGB=0,255,255   Box colour for 1-99% ON on Overview  

Graph (Not Used for SP Plus) 
OffRGB=255,255,255  Box colour for 100% ON on Overview  

Graph (Not Used for SP Plus) 
MaxDaySel=0 
OverviewStyle=1 
PeriodSel=5 
MeasYAxis=1 
Meas1RGB=255,  0,  0  Channel 1 trace colour for Minimum 
Meas2RGB=0,  0,255  Channel 1 trace colour for Average 
GridRGB=206,206,206  Graph grid colour (SPT, SPPLUS, SPC) 
Meas3RGB=0,255,  0  Channel 1 trace colour for Maximum 
Meas4RGB=128,128,128  Channel 2 trace colour for Minimum 
Meas5RGB=0,255,255  Channel 2 trace colour for Average 
Meas6RGB=255,  0,255  Channel 2 trace colour for Maximum 
Meas7RGB=255,255,  0  Channel 2 trace colour for Minimum 
Meas8RGB=0,128,  0  Channel 2 trace colour for Average 
Meas9RGB=0,  0,  0  Channel 2 trace colour for Maximum 
Orientation=1 
 
To determine which colours to use, you can experiment using 
Paintbrush (a paint program that comes with Windows). After 
starting Paintbrush, Select the Options menu, and then select Edit 
Colors.  A box will pop up with sliders for red, green and blue. To 
the right of the slider is a number that will change from 0 to 255 as 
you move the slider from left to right. As you move each of the 
sliders, the box on the extreme right will change colour. Move the 
sliders around until the box is the colour you want, then note the 
numbers beside the red, green and blue sliders. These are the 
numbers you will enter into the SILPRTNR.INI file using the text 
editor, Simply replace the old RGB values with the new ones. 
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The remaining items in the file reflect the various options that have 
been selected while using the software. They can also be edited, 
but it is probably easier to just change the option from within Silent 
Partner. 
 
[ComPort] 
Port=1      Communications port number 
Type=1      Default Logger Type. 
 
[Directory] 
Data=C:\SP\DATA   Default directory for data storage and 
retrieval 
Export=C:\SP\EXPORT  Default directory exported data 
 
[Costing] 
Enabled=1     Costing Display 1=On, 0=Off (SPA) 
Rate=0.080000    Electricity cost per Kwh, in dollars 
Load=6000.000000   Load value in Watts for calculating 
costing 
 
[Measurement] 
MConvert=1 
MConvert1=2 
MConvert2=1 
 
[Options] 
BattWarn=Status,Param 
LoBattV=8.0  Battery voltage after which Silent  

Partner will warn of a low battery 
[PrintPref] 
LogoSummary=1    1 = Print Logo on Summary Page, 

0 = don’t print logo on Summary Page 
LogoStats=1     1 = Print Logo on Stats Page, 0= don’t 

printlogo on Stats Page  
IncludeBitMap=1   1 = Use bitmap file specified below, 

0 = don’t use bitmap file 
BMPFile=C:\TECH5CL.BMP Name and path of bitmap logo file used 

on reports 
LogoL1=      Text on first line after logo 
LogoL2=      Text on second line after logo 
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